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1 Start Successfully 

1.1 About the Manual 
This manual is intended for all users who want to learn how to use Nero Express. It is 

process-based and explains how to achieve a specific objective on a step-by-step basis. 

To make best use of this documentation, please note the following conventions: 

 

Indicates warnings, preconditions or instructions that have to be 

precisely followed. 

 
Indicates additional information or advice. 

1. Start … 
The number at the beginning of a line indicates a prompt for action. 

Carry out these actions in the order specified. 

 
Indicates an intermediate result. 

 
Indicates a result. 

OK 
Indicates text passages or buttons that appear in the program 

interface. They are shown in boldface. 

(see…) 
Indicates references to other chapters. They are executed as links and 

are shown in red and underlined. 

[…] Indicates keyboard shortcuts for entering commands. 

  

1.2 About Nero Express 
Nero Express provides all the performance and efficiency of Nero Burning ROM with a 

simplified user interface. Whether you are a beginner or an expert, Nero Express guides you 

quickly and easily through your desired burning tasks. The default settings are selected to 

automatically produce the best possible results. Using the program is remarkably easy: 

simply select the project to be burned, add the files, and start burning. 

With Nero Express that is included in Nero 2015 you can save audio files from an Audio CD 

to the hard drive. In the process, the files are encoded, i.e. converted into a format that the 

computer can read. The Audio CD can be automatically identified with Gracenote. So called 

metadata such as title, genre, and track title are accessed by the Gracenote Media Database 

and associated to the tracks. That way you have audio files that are accurately and fully 

named after the encoding process. 

 



Start Successfully 

 

 
Nero Express 7  

 

Music recognition technology and related data are provided by Gracenote®. 
Gracenote is the industry standard in music recognition technology and related 
content delivery. For more information, please visit www.gracenote.com. 

 

1.3 Versions of Nero Express 
Nero Express is available in versions with different features. 

The full version of Nero Express in Nero 2015, or Nero 2015 Platinum provides the complete 

range of functions, including multimedia features such as saving audio tracks and burning 

BD-Videos. 

Different versions of Nero Express Essentials are available. Essentials or OEM software may 

differ from the full version in a more or less broad functional range. The feature limitations of 

your single Essentials version are determined by the contract partner from whom you 

purchased your copy. 

Nero Express Essentials in Nero 2015 may not offer the following features compared to the 

full version: 
 

  Creating labels with LightScribe 

  Creating labels with Labelflash 

  Full SecurDisc functionality 

  Audio CD compilation 

  AVCHD compilations 

  BDMV compilation 

  DVD-Video compilation 

  Jukebox compilation 

  Burn from Image 

  ISO support 

  Copying discs 

  Simultaneous burning with multiple burners 

  Cross fade with previous track 

  Save Tracks 

  Music title recognition with Gracenote 

 

 

Gracenote Plug-in 

You will need the Gracenote Plug-in to identify single audio files. 

You can obtain the plug-in at www.nero.com. The plug-in is already included in 
the full version of Nero Express in Nero 2015 or Nero 2015 Platinum. 

 

In addition, the encoding and decoding formats in Nero Express Essentials are restricted. 

The mp3PRO Plug-in is included as a trial version. 

http://www.gracenote.com/
http://www.nero.com/
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mp3PRO Plug-in 

You will need the mp3PRO Plug-in for unlimited MP3 and mp3PRO 
encoding/decoding. 

The plug-in can be added to Nero 2015. You can obtain the plug-in at 
www.nero.com. The plug-in is already included in the full version. 

 

Nero Express in Nero BurnExpress 3 provides basically the same feature range as the full 

version of Nero Express in Nero 2015 or Nero 2015 Platinum.  

The following features are not available:  
 

  SecurDisc Surface Scan 

  mp3 Pro Encoding 

1.4 Working with the Application 
The main function of Nero Express is to select files and folders and to burn them to a disc. 

This is done in three basic steps. For each step, a new screen is displayed: 
 

  Select a task in the start screen. 

  Select the files to be burned. 

  Start the burn process. 

Additionally, you can set options regarding the files in the compilation and regarding the burn 

process. 

1.5 Starting the Program 
There are several ways to open Nero Express, depending on various factors such as the 

product you have installed and the operating system you are using. 
 

  On Windows 7 and earlier versions of Windows, you can start Nero Express via: 
 

  Start (the start icon) > (All) Programs > Nero > Nero 2015 > Nero Express 
 

  the  Nero 2015 desktop icon 

 

 

The application launcher  Nero 2015 provides easy access to Nero 

applications, offers information about the main use cases, and links to tutorials 
and other interesting Web sites by Nero. 

 
 

  On Windows 8, you can start Nero Express via: 

  the Nero 2015 tile (Windows 8 Start screen) or the  Nero 2015 desktop icon 

(Windows 8 desktop) if you use Nero 2015 

http://www.nero.com/
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  the Nero Express tile (Windows 8 Start screen) or the Nero Burning ROM 2015 desktop 

icon (Windows 8 desktop) if you use Nero Burning ROM 2015 as a standalone product 

 

1.6 System Requirements 
Nero Express is part of the Nero product you have installed. Its system requirements are the 

same. Detailed system requirements of this and all other Nero products can be found in the 

Support section on our Web site www.nero.com. 

http://www.nero.com/
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2 Start Screen 
The main screen in Nero Express is the starting point for all actions. Click here on the 

relevant menu icons to go to the desired screen where you can compile and work on your 

project. The selection is categorized into two areas: several formats or options are available 

for the single compilation methods. 

Click the  button in the left margin of the window to display an extended area with 

additional options and features. 

 
Start Screen  

The following compilation methods are available: 

Data Allows you to compile and burn all types of files and folders. 

Music Allows you to compile and burn audio files as Audio CD for example. 

Videos Allows you to compile and burn video files as DVD-Video for example. 

Image, Project, 

Copy 

Allows you to copy a source disc and to load an image file or a saved 

project. 

Print LightScribe 

Label 

Displays the Disc Label screen. 

This is where you can create or load a label in order to print on the 

label side of special CDs/DVDs in the recorder. 

A LightScribe recorder must be selected to enable the option.  

Only available in the full version of Nero Express in Nero 2015. 
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The actual disc formats that are available and the actual disc types (e.g. DVD) to 

which can be written depend on the selected recorder. 

 

See also 

  Loading a Disc Image or Saved Project →44 

  LightScribe →45 

  Data Disc →16 

  Music →23 

  Video →39 

2.1 Extended Area (Start Screen) 
You can access the additional options and features in the extended area of the start screen 

by clicking on the  button in the left margin of the window. The extended area is available 

in all Nero Express screens. 

The following menu icons are available: 

Switch to Nero 

Burning ROM 

Closes Nero Express and opens the start screen of Nero Burning 

ROM. Nero Burning ROM is able to open Nero Express compilation 

files and Nero Express is able to open Nero Burning ROM 

compilation files. 

This option is only available in the extended area of the start screen. 

If you decide to create a project with Nero Express, the option Saves 

the active project is displayed in all of the other windows at this 

point. 

Only available with Nero 2015. 

Saves the active 

project 

Opens the Save As window to save your compilation. The file links 

and settings to be burned are saved. 

Options 
Opens the Options window to customize Nero Express to suit your 

requirements.  

Save Audio Tracks 

Opens the Copy Audio CDs to Hard Drive to copy audio files from 

CD to the hard drive. 

Only available with Nero 2015. 

Save Data Track 
Opens the Select Track window in which you can save the track of a 

data disc as an image file. 

Erase Disc 
Opens the Erase Rewritable Disc window to erase data from a 

rewritable disc. 

Disc Info Opens the Disc Info window to display information about the 
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inserted disc. The total capacity and available capacity are 

displayed, in addition to the tracks and sessions. 

Create Covers and 

Labels 

Opens Nero CoverDesigner. Nero CoverDesigner is used to create 

and print labels and booklets for burned discs. 

Please see the separate Nero CoverDesigner user manual for full 

instructions on how to make professional looking covers and labels. 

Only available with Nero 2015. 

SecurDisc Settings Defines the settings for burning a SecurDisc disc. 

Burn Label 

Opens the Burn Label window, in which you can create or load a 

label in order to print a label and/or print directly on the data side of 

special discs in the recorder. 

Available with a Labelflash recorder only. The recorder must be 

selected to enable the option. 

Only available in the full version of Nero Express in Nero 2015. 

Recorder 
Defines the recorder that you want to use for burning and/or the Nero 

Image Recorder. 

  

 

See also 

  Configuration Options →76 

  Copy Audio CDs to Hard Drive →34 

  Erase Rewritable Disc Window →66 



Compilation Screen 

 

 
Nero Express 13  

3 Compilation Screen 
You can access the Nero Express compilation screens by selecting the compilation type you 

want in the start screen. You can add data to your projects in the compilation screens and 

customize the directory structure on the disc to suit your requirements. The capacity bar near 

the bottom of the window indicates how much space is being used by the data on the disc. 

Essentially, all compilation screens have the same structure. 

 
Compilation screen 

The following setting options are in general available in the compilation screen: 

Button 

Add 

Opens the Add files and folders window. 

Clicking on the little triangle allows you to open Nero 

MediaBrowser in order to add media files.   

Button 

Remove 
Removes the selected file. 

Button 

Play 
Plays a selected audio or video file. 

Button 

Back 
Returns to the start screen. 

Button 

Next 
Switches to the Final Burn Settings screen. 
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The following setting options are additionally available for Audio CD compilation: 

Button 

Properties 
Opens the Audio Track Properties window for Audio CDs. 

Check box 

Normalize all audio 

files 

Enables a filter that brings the volume of the audio files to be 

burned into line with one another. This is recommended 

particularly if the files originate from different sources.  

Check box 

No pause between 

tracks 

Establishes that the audio files merge into one another without a 

pause. If the check box is cleared, a pause of two seconds is 

inserted between the files. 

We strongly recommend using the disc-at-once burn mode. 

Otherwise the zero pause length may not be supported by all 

recorders and/or a very short clicking noise may be heard between 

tracks. 

  

The following setting option is additionally available for all DVD compilations: 

Selection list 

DVD9 (8.5 GB) /  

DVD5 (4.7 GB) 

Allows you to expand or shrink the capacity bar according to the 

type of DVD you are going to burn. Choose the DVD9 (8.5 GB) 

option for a double layer DVD (DVD DL) and DVD5 (4.7 GB) for a 

single layer DVD. 

  

The following setting option is additionally available for all Blu-ray compilations: 

Selection list 

BD QL (BDXL) (128 

GB) /  

BD TL (BDXL) (100 

GB)  

BD DL (50 GB) /  

BD (25 GB) 

Allows you to expand or shrink the capacity bar according to the 

type of Blu-ray Disc you are going to burn: 

BD QL (BDXL) (128 GB) for a quadruple layer Blu-ray Disc,  

BD TL (BDXL) (100 GB) for a triple layer Blu-ray Disc,  

BD DL (50 GB) for a double layer Blu-ray Disc (BD DL) and 

BD (25 GB) for a single layer Blu-ray Disc. 

  

 

 

Actual capacity of media formats 

The actual capacity of the DVD5, DVD9, BD DL, and BDXL media formats is less 
than as stated by the disc manufacturers. For example, the actual capacity of a 
4.7 GB DVD5 is around 4.38 GB only.  

This is because of different conversion systems. A DVD5-media format can 
handle 4.700.000.000 bytes, but this number is not equal to the 4.7 GB stated by 
the disc manufacturers. The correct conversion factor for bytes is not 1000, but 
1024:  

1024 byte = 1 KB  

1024 KB * 1024 KB = 1 MB  
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1024 KB * 1024 KB * 1024 KB = 1 GB  

A DVD can handle 4.700.000.000 bytes:  

4.700.000.000 bytes = 4.589.843 KB = 4.482 MB = 4.377 GB 

The capacity bar in Nero Express will always show you the correct amount of 
bytes measured in MB or GB. 

 

See also 

  Compilation Settings →77 
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4 Data Disc 

4.1 Compiling Data Disc 
With Nero Express you can compile and burn all types of files and folders. If a Blu-ray 

recorder is installed on your computer you can burn data CDs, data DVDs and data Blu-ray 

Discs. If you have a CD recorder you can only burn data CDs. The procedure for all data 

compilation methods is identical. 

A data disc is particularly useful for storing files on a disc and for burning backups. 

To create a data disc, proceed as follows: 

 1. Click the Data menu icon in the Nero Express start screen. 

 The data disc options are displayed. 

 2. Click the option you require: Data CD, Data DVD, or Blu-ray Data Disc. 

 The Disc Content compilation screen for data discs is displayed. 

 
Disc Content compilation screen 

 3. If you want to add files using your browser: 

 1. Click the Add button. 

  The Add files and folders window is opened. 

 4. If you want to use Nero MediaBrowser to add media files: 

 1. Click the triangle next to the Add button and choose Add > File from Nero 

MediaBrowser. 

  Nero MediaBrowser is opened. 

 5. Select the files that you want to add to the compilation and click the Add button. 

 6. Repeat the previous step for all files that you want to add. 
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 7. Click the Close button. 

 The files are added to the compilation and displayed in the compilation screen. 

 8. Click the Next button. 

  You have successfully compiled a data disc and can now burn this compilation. 

See also 

  Compilation Screen →13 

4.2 Compiling SecurDisc disc 

SecurDisc is a technology with which you can create discs with special protection properties. 

No special hardware is needed. 

Discs that are created with Nero Express and the SecurDisc compilation type include data 

integrity and reconstruction. Additional SecurDisc features include the possibility to protect 

the data on your disc against unauthorized access using a password, to digitally sign the 

disc, and to configure the data redundancy. 

To be able to copy the protected data to your hard drive and to check the security of the data 

you will need a special application named Nero SecurDisc Viewer. The Nero SecurDisc 

Viewer is burned automatically to the SecurDisc disc and can be downloaded free of charge 

at www.securdisc.net or www.nero.com. 

 

 

More information on SecurDisc technology can be found at www.securdisc.net. 

 

 

 

This function is limited in the Essentials version. The full version offers unlimited 

password protection, unlimited data redundancy, and the digital signature feature. 

You can always upgrade your Essentials version at www.nero.com to get the full 

version with all the functions. 

 

To compile a SecurDisc disc, proceed as follows: 

 1. Click the Data menu icon in the Nero Express start screen. 

 The data disc options are displayed. 

 2. Click the SecurDisc option you require. 

 The Disc Content compilation screen for SecurDisc discs is displayed. 

http://www.securdisc.net/
http://www.nero.com/
http://www.securdisc.net/
http://www.nero.com/
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SecurDisc DVD compilation 

 3. If you want to add files using your browser: 

 1. Click the Add > Files button. 

  The Add files and folders window is opened. 

 4. If you want to use Nero MediaBrowser to add media files: 

 1. Click the triangle next to the Add button and choose Add > File from Nero 

MediaBrowser. 

  Nero MediaBrowser is opened. 

 5. Select the files that you want to add to the compilation and click the Add button. 

 6. Repeat the previous step for all files that you want to add. 

 7. Click the Close button. 

 The files are added to the compilation and displayed in the compilation screen. 

 8. If you want to enable the password protection for all files: 

 1. Select the Password protection check box in the extended area of the compilation 

screen. 

  The SecurDisc – Protect Data window is opened. 
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 2. Enter the desired password in the Password input area and then click the OK button. 

  A lock symbol shows that all data is protected. 

 

 

When appropriate, a wizard offers suggestions in an additional Tips dialog box 
when entering and selecting the password. The wizard estimates the security 
level, i.e. the quality of the password, during entry. 

 

 9. If you want to sign the disc with a digital signature: 

 1. Select the Digital signature check box in the extended area of the compilation screen. 

  The SecurDisc – Digital Signature window is opened. 
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 2. If you have already created a digital key, click the Browse button and select the key. 

 3. If you want to create a digital key, click the Start button. 

  The SecurDisc – Create Digital Key window is opened. 

 4. Read the instructions and click the Next button. 

  The SecurDisc Key Creation Process window is opened. 

 5. Move your mouse at random until the creation process is complete. 

  Nero Express uses the random data to create the SecurDisc key. You can monitor the 

status of the creation process using the progress bar. The Next button is enabled as 

soon as the process is complete. 

 6. Click the Next button.  

  The SecurDisc – Key Creation Completed window is opened. 

 7. Enter a file name for the key you have created and click the Finish button. 

  The SecurDisc – Digital Signature window is opened again and the selected key 

appears in the drop-down menu. 

 8. Click the OK button. 

  The corresponding window is opened to inform you that the disc is being digitally 

signed with the selected key. 

 9. Click the OK button. 
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You can pass on the relevant public key to recipients to enable them to verify the 
signature. 

 

 10. If you want to enhance the burning speed by limiting the data redundancy or to configure the 

data redundancy: 

 1. Select the Data redundancy check box in the extended area of the screen.. 

  The option buttons are enabled. 

 2. Select the desired reliability level. 

 

 

If the Data redundancy check box is cleared, the disc will be filled completely 
with copies of the chosen data and checksums. A display panel in the compilation 
screen indicates the current redundancy level. 

 

 11. Click the Next button. 

  You have compiled a SecurDisc disc with settings according to your requirements 

and can now burn the disc. 

4.3 Saving Data Track 
With Nero Express you can save a data disc as an image file. The image file can later be 

burned to a recordable disc. The result is a copy of the original data disc. 

To save the data disc as an image file, proceed as follows: 

 1. Insert the data disc in a drive. 

 2. Click the Save Data Track button in the extended area of the start screen. 

 The Select Track window is opened. The tracklist shows you the sessions and data 

tracks that are found on the disc. Due to the technical reasons, only the first data track of 
the first session can be saved. 
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Select Track 

 3. Select the first data track. 

 4. Click the Save Track button. 

 The Save As window is opened. 

 5. Select a file name and a storage location. 

 6. Select the desired output format (ISO or NRG) for the image file in the Save As drop-down 

menu. 

 7. Click the Start button. 

 The Progress window is opened and displays the progress made while saving. When 

the save process is complete, the window is closed automatically. 

  You have successfully created an image file starting from a data disc. Now you can 

burn the image file to a disc. 
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5 Music 

5.1 Create Audio CDs 
 

 

Some of the functions mentioned here are restricted or not available in the 

Essentials version. You can always upgrade your Essentials version at 

www.nero.com to get the full version with all the functions. 

 

With Nero Express you can create an Audio CD that contains music files. It can be played in 

all standard CD players. To compile an Audio CD, source files with different audio formats 

are automatically converted into Audio CD format before being burned. 

 

 

Some CD players cannot play CD-RWs. Use CD-R discs to burn Audio CDs. 

 

 

 

The encoding and decoding formats in the Essentials version are limited. You can 

always upgrade your Essentials version at www.nero.com to get the full version 

with all the functions. 
 

 

 

mp3PRO Plug-in 

You will need the mp3PRO Plug-in for unlimited MP3 and mp3PRO 
encoding/decoding. 

The plug-in can be added to Nero 2015. You can obtain the plug-in at 
www.nero.com. The plug-in is already included in the full version. 

 

To create an Audio CD, proceed as follows: 

 1. Click the Music menu icon in the Nero Express start screen. 

 The compilation methods for music are displayed. 

 2. Click the Audio CD button. 

 The My Audio CD compilation screen for Audio CDs is displayed. 

http://www.nero.com/
http://www.nero.com/
http://www.nero.com/
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My Audio CD compilation screen 

 3. If you want to add files using your browser: 

 1. Click the Add > Files button. 

  The Add files and folders window is opened. 

 4. If you want to use Nero MediaBrowser to add audio files: 

 1. Click the triangle next to the Add button and choose Add > File from Nero 

MediaBrowser. 

  Nero MediaBrowser is opened with the Music tab enabled. 

 5. Select the audio file that you want to add to the compilation and click the Add button.  

 6. Repeat the previous step for all audio files that you want to add. 

 7. Click the Close button. 

 The audio files are added to the compilation and displayed in the compilation screen. 
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 8. Customize the properties of the audio files to suit your requirements. 

 9. Click the Next button. 

  You have successfully compiled an Audio CD and can now burn this compilation. 

See also 

  Compilation Screen →13 

  Copy Audio CDs to Hard Drive →34 

5.1.1 Customizing Properties of The Audio File 

You can display and/or make changes to the audio file properties on the Track Properties, 

Indexes, Limits, Splits and Filters tabs of the Audio Track Properties window. To open 

the window, select an audio file in the compilation screen My Audio CD for Audio CDs and 

click the Properties button. 

5.1.1.1 Track Properties Tab 

On the Track Properties tab you will find basic information on the selected file in the 

Source information area. To open the window, mark an audio file in the compilation screen 

for Audio CDs and click the Properties button.  
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Audio Track Properties 

The following input areas are available in the Properties area: 

Input field 

Title (CD TEXT) 

Defines a title which is saved as CD TEXT. CD players that support 

CD TEXT show the title name entered here. 

Only Latin characters can be displayed as CD TEXT. CD TEXT can 

only be written in disc-at-once mode. 

Input field 

Artist (CD TEXT) 

Defines the artist which is saved as CD TEXT. CD players that 

support CD TEXT show the artist's name entered here. 

Only Latin characters can be displayed as CD TEXT. CD TEXT can 

only be written in Disc-At-Once mode. 

Input field 

Pause 

Defines the length of the pause in seconds or frames between the 

selected audio file and the previous one. 

Input field 

International 

Standard 

Recording Code 

(ISRC) 

Identifies the CD title using a 12-character digital code. The ISRC is 

entered in the subcode and included silently. 

If you do not know the ISRC, you should leave this input field blank.  

Check box 

Protection 

Sets the copy protection bit for the corresponding track on the Audio 

CD. As most CD recording applications simply ignore this bit, copy 

protection cannot be ensured. A warning message will be opened in 

Nero Express while copying an Audio CD with copy protected tracks. 

Check box 

Cross fade with 

previous track 

Defines a crossfade between this and the previous audio file. You 

can specify the length of the crossfade in seconds or in sectors.  
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5.1.1.2 Indexes, Limits, Split Tab 

On the Indexes, Limits, Split tab you can set and delete indexes and split audio files to 

create two or more shorter ones. The tab consists of the Oscilloscope and Positions areas. 

 
Indexes, Limits, Split Tab 

 

Audio files are displayed graphically in the Oscilloscope area. The following configuration 

options are available in the Positions area: 

Selection lists 

Start/End 

Shows the positions for the beginning and end of the audio file on 

the CD. 

Button 

New Index 

Sets a new index position at the selected position. For the CD player 

this is the position from which a new song starts, and the player can 

also jump to it directly. However, not all CD players support this 

feature. 

Button 

Edit 

Opens the Edit track limit dialog box. 

You can enter the exact position of a split. 

Button 

Delete 
Deletes a selected index. 

Button 

Split 
Splits the audio file at the marked position. 

Button 

Play 

Plays the audio file from the marked position.  

During playback, the Stop playing button is displayed. 
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Button 

Stop playing 

Stops playback of the audio file.  

If playback is stopped, the Play button is displayed again. 

Button 

Split at Index 

Positions 

Splits the audio file at the set index positions. 

Button 

Zoom In 
Enlarges the graphical representation of the audio file. 

Button 

Zoom Out 
Reduces the graphical representation of the audio file. 

Button 

Full View 
Displays a graphical representation of the entire audio file. 

  

5.1.1.3 Filters Tab 

The Filters tab includes filters that improve or change the quality of the music. The so-called 

non-destructive procedure is used for processing, i.e. the actual recording is not changed, 

but flags are simply set that can be canceled at any time. No additional audio data is 

created. The audio files on hard drive are not modified during this procedure. 

 
Audio Track Properties window, Filters tab 
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The following configuration options are available in the Audio Track Properties window: 

Check box 

Normalize 

Sets the volume of an audio file to a preset value. This filter can be 

useful to bring the volume of files originating from different sources 

into line with one another. 

Check box 

Declick 

Removes clicking and scratching noises, such as those on old LPs 

for example. 

Check box 

Hiss Reduction 

Reduces or removes the hiss on an audio file. All frequencies 

below a certain threshold (hiss level) are removed. 

Check box 

Fade In 

Fades in the volume of an audio file from zero to full volume. This 

filter can be useful for shortening files. 

Check box 

Fade Out 

Fades out the volume of an audio file from full volume to silence. 

This filter can be useful for shortening files. 

Check box 

Stereo Widening 

Increases/reduces the stereo effect of an audio file. This filter only 

works if the original file was recorded in stereo. 

Check box 

Karaoke 

Fades out the vocals on an audio file. This is done by fading out 

the parts of a song that are the same in both stereo channels. 

Check box 

Echo 
Adds an echo to the audio file. 

Check box 

Equalizer 

Opens an equalizer so you can change the volume, bass, and 

pitch in different frequency ranges. 

Button 

Test Selected Filters 

Plays the audio file and applies the activated filters. During 

playback, the configuration options for the filters can be changed, 

allowing the effect to be controlled. 

  

 

5.2 Create Jukebox Disc 
Nero Express can be used to compile discs with audio formats you require (e.g. Nero AAC or 

WMA). In contrast to Audio CDs that can only be burned on CDs, you can burn these 

compilations of different audio formats on other disc types – provided a corresponding 

recorder is installed on your computer. The procedure for compilation methods is identical. 

You can opt for a single format or a mix of audio formats of your choice. In contrast to data 

disc, a jukebox disc can display metadata (title, artist, genre, ...) about the audio file. 
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Nero Express does not convert the audio files when creating a jukebox disc. In 
other words, MP3 files are burned as MP3 files for example. Most CD players 
cannot play such discs. 

 

From a technical point of view, a compilation of special audio formats is a data disc. There is 

no difference between creating a jukebox disc and creating a data disc. Please be sure to 

select the corresponding entry in the start screen. 

See also 

  Compilation Screen →13 

  Compiling Data Disc →16 

5.3 Gracenote Music Recognition 
With Gracenote MusicID Nero Express can identify music files. So called metadata such as 

artist, title, and genre are accessed from the Gracenote Media Database and displayed in 

Nero Express.  

Identification is possible for single audio files as well as complete original Audio CDs.  

If the metadata of the Audio CD is not yet included in the database then you can enter it and 

make it available. The metadata is sent to Gracenote and added into the database. 

With Gracenote you can have audio files identified out of any sort of audio compilation. This 

is particularly useful when audio files are not named or are only partially named. In this way 

your music collection is correctly tagged with all information. 

During the following actions, original Audio CDs can be automatically identified in Nero 

Express with Gracenote MusicID. 
 

  Copying Audio CD 

  Saving Tracks from the Audio CD to Hard Drive 

 

 

Gracenote Plug-in 

You will need the Gracenote Plug-in to identify single audio files. 

You can obtain the plug-in at www.nero.com. The plug-in is already included in 
the full version of Nero Express in Nero 2015 or Nero 2015 Platinum. 

 

 

 

Music recognition technology and related data are provided by Gracenote®. 
Gracenote is the industry standard in music recognition technology and related 
content delivery. For more information, please visit www.gracenote.com. 

 

5.3.1 Identifying Audio Files 

You can have the added audio files in the music compilations identified with Gracenote and 

access metadata such as artist and title from the Gracenote Media Database. 

 

http://www.nero.com/
http://www.gracenote.com/
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Some of the functions mentioned here are restricted or not available in the 

Essentials version. You can always upgrade your Essentials version at 

www.nero.com to get the full version with all the functions. 
 

 

 

Gracenote Plug-in 

You will need the Gracenote Plug-in to identify single audio files. 

You can obtain the plug-in at www.nero.com. The plug-in is already included in 
the full version of Nero Express in Nero 2015 or Nero 2015 Platinum. 

 

To do this, proceed as follows: 

 1. Select the type of compilation to burn a music CD. 

 The compilation screen is displayed. 

 2. Add audio files from the hard drive to the music compilation. 

 3. Select one or more audio files in the compilation. 

 4. Right-click to open the context menu. 

 5. Select the Get metadata entry. 

 The audio files are analyzed and the required information is sent to Gracenote. The Edit 

Meta Data window is opened. The metadata received by Gracenote is displayed in the 
New Info area. 

http://www.nero.com/
http://www.nero.com/
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Edit Meta Data window 

 6. If necessary, edit the metadata, e.g. track number, title, artist, album title, year, and genre. 

 7. Click the Apply button. 

 The Edit Meta Data window is closed. 

  The metadata is shown in Nero Express. If the Adjust all file name(s) check box is 

selected, the file on hard drive is renamed accordingly (if technically possible). 

5.4 Rip Audio CD 
With Nero Express you can save audio files from an Audio CD to the hard drive. In the 

process, the files are encoded, i.e. converted into a format that the computer can read. The 

audio file is usually compressed. 

Nero Express obtains information about metadata such as title, artist, and track title from 

different sources. You can check exactly what metadata will be written into the audio files. 

Metadata about the Audio CD is available from different sources: The Audio CD's own 

CD TEXT, Gracenote Media Database and your local database.  

 ▲  The Gracenote Media Database holds metadata about many Audio CDs. With 

Gracenote MusicID Nero Express can identify the Audio CD and access metadata from 

the Gracenote Media Database. 
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 ▲  Many Audio CDs contain CD TEXT which includes metadata such as the title of the 

CD, the name of an audio file or the name of an artist. 

 ▲  The local database is stored on your PC and contains information for each Audio 

CD that was ripped or copied using Gracenote. The local database is useful, when you 

change title or artist but don't want to send the changes to Gracenote (because the 

changed title makes sense only to you, for example). 
 

 

Music recognition technology and related data are provided by Gracenote®. 
Gracenote is the industry standard in music recognition technology and related 
content delivery. For more information, please visit www.gracenote.com. 

 

 

 

Audio files from copy-protected Audio CDs cannot be saved. 

 

 

 

The encoding and decoding formats in the Essentials version are limited. You can 

always upgrade your Essentials version at www.nero.com to get the full version 

with all the functions. 
 

 

 

mp3PRO Plug-in 

You will need the mp3PRO Plug-in for unlimited MP3 and mp3PRO 
encoding/decoding. 

The plug-in can be added to Nero 2015. You can obtain the plug-in at 
www.nero.com. The plug-in is already included in the full version. 

 

To save audio files, proceed as follows: 

 1. Click the Save Audio Tracks button in the extended area of the screen. 

 The Save Audio Tracks to Hard Drive window is opened. 

 2. Insert your Audio CD into a drive. 

 The disc is being analyzed. Metadata information is obtained from Gracenote, CD TEXT 

and the local database and displayed, if available. 

http://www.gracenote.com/
http://www.nero.com/
http://www.nero.com/
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Save Audio Tracks to Hard Drive window 

 3. Select the metadata information for your Audio CD from the CD drop-down menu. 

 4. Select the tracks that you want to save on the hard drive. 

 5. Click the Output tab. 

 The Output tab is opened. 

 6. Select the target file's audio format in the File Format drop-down menu. 

 7. Choose a method for creating the file name in the Mode for Creating File Names drop-

down menu. 

 8. Define other settings according to your preferences. 

 9. Click the Copy button. 

 Conversion starts. A folder with the album name is created in the desired folder. The 

audio files are saved in this folder and named according to the method you chose.  

  You have saved audio files. 

5.4.1 Copy Audio CDs to Hard Drive 

Define the settings for audio files to be saved on the hard drive in the Save Audio Tracks to 

Hard Drive window. Open the window in the extended area of the start screen by clicking 

Save Tracks. 
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Copy Audio CDs to Hard Drive - Source 

The following setting options are available: 

Tab 

Source 
Specifies settings for the source of the audio data. 

Tab 

Output 
Sets output files configuration options. 

Button 

Copy 
Starts the copy or save process. 

  

 

See also 

  Create Audio CDs →23 

5.4.1.1 Source Tab 

The Source tab displays the audio files on the Audio CD. The functions of the control 

buttons correspond to the familiar control buttons on CD players. 
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Save Audio Tracks to Hard Drive - Source 

The following setting options are available: 

Drop-down menu 

Source drive 
Selects the drive where the Audio CD is inserted. 

Drop-down menu 

CD 

Selects from which source metadata is used: 

 Gracenote Media Database 

 CD TEXT 

 Your local database (only available if you have ripped or copied 

the Audio CD before) 

Title Selection List 
Displays the tracks on the Audio CD. You can select individual tracks 

to copy by selecting the respective check box.  

Button 

Refresh 

Obtains all available information again. Nero Burning ROM sends a 

new query to the Gracenote Media Database and completes the 

Audio CD's metadata including artist, title name, and genre if a 

matching entry exists in the database. Also, CD TEXT and 

information from your local database, if available, are obtained. 
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Input fields 

Album / Album 

Artist / Year 

Displays or specifies metadata for the album, album artist and year. 

Selection list 

Genre 
Displays or specifies the genre. 

Button 

Cover 

Loads a cover from your hard drive. 

 

Check box 

Submit entered 

metadata 

anonymously to 

Gracenote 

Sends changed or newly filled in Audio CD metadata to Gracenote in 

order to enter them into the Gracenote Media Database. This 

information is also stored in your local database. The local database 

is especially useful when you have changed metadata but don't want 

to send the changes to Gracenote (because the changes make 

sense only to you, for example, or you don't have an Internet 

connection at the moment). 

  

5.4.1.2 Output Tab 

You can define the properties of the audio files to be created on the Output tab. 

 
Copy Audio CDs to Hard Drive - Output 
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The following setting options are available: 

Input window 

Output directory 
Selects the storage location for the output file. 

Button 

Browse 
Opens a browser window where you can select a storage location. 

Drop-down menu 

Mode for creating 

file name 

Selects the method to be used for creating the name of the output 

file. 

Check box 

Automatically 

generate a playlist 

of stored audio 

tracks 

Creates a playlist of the saved audio files. A playlist is a list of the 

ripped audio files in the right order with the right metadata. It is a 

very convenient tool − you simply have to select the playlist to add all 

the audio files it contains to an audio compilation or a playback 

application. 

Drop-down menu 

Playlist format 
Selects a format for the playlist. 

Drop-down menu 

File format 

Selects the output audio format for the selected audio file. The 

selected file format is available as the first entry the next time it is 

called up. You can choose between Nero AAC Audio, MP3 Audio, 

WAVE, AIFF, FLAC and Ogg Vorbis . 

Drop-down menu 

Quality 

Selects the bitrate for the selected audio file format. If the bit rate is 

small, less data is transferred. The file is then small, but quality is 

lower. If the bit rate is high, more data is transferred. The file size is 

then large, but the quality is high. A value of 128 for MP3 files is near 

CD quality. For the MP3 Audio file format you can also select if you 

want to create an MP3 file or an mp3PRO file. Only available if you 

selected the Nero AAC Audio or MP3 Audio file format. 

Check box 

Force compatibility 

with iPod 

Makes Nero AAC Audio available for an iPod. 

Is only available if you selected the Nero AAC Audio output format. 

Check box 

Disable ID3v2 

Unsynchronization 

Disables the ID3v2 Unsynchronization during the decoding process. 

ID3v2 Unsynchronization is a part of the MP3 decoding process. It 

increases the chance that the MP3 file can be played even with old 

software or hardware that does not support ID3v2. However, some 

devices that support ID3v2 do not support ID3v2 Unsychronization. 

The display of images or text tags might be corrupt on such devices 

when playing MP3 files with unsynchronized ID3v2. Select the check 

box if you have encountered such problems. 
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6 Video 

6.1 Compiling DVD-Videos 
With Nero Express you can burn DVDs made up of premastered DVD-Video files from your 

hard drive. You can show your burned DVDs on almost all DVD players. You can use Nero 

Express to burn a DVD if the DVD video title, i.e. a complete DVD folder structure, is already 

available. 

 

 

In Nero Express it is not possible to convert video files to DVD-Video, an AVCHD 

video, or a BDMV-Video. Converting video files to DVD-Video, to AVCHD video, 

or BDMV-Video is possible in Nero Video for example. Nero Video is included in 

the full version of Nero 2015. More information about Nero Video is available on 

the Web site www.nero.com, and more information about video editing is 

available in the separate Nero Video manual. 

 

To compile a DVD-Video, proceed as follows: 

 1. Click the Videos menu icon in the Nero Express start screen. 

 The video options are displayed. 

 2. Click the DVD-Video Files option. 

 The DVD-Video Files compilation screen is displayed. 

 3. Click the Add button. 

 The Add files and folders window is opened. 

 4. Select the DVD-Video files that you would like to add to the compilation and click the Add 

button. 

 5. Click the Close button. 

 The DVD-Video files are added to the compilation and are displayed in the compilation 

screen. 

http://www.nero.com/
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DVD-Video files compilation screen 

 

 

If the DVD-Video files selected are larger than 4483 MB and if a DVD recorder 
which can burn DVDs with 2 layers (DVD DL) is installed, you can select the 
DVD9 (8152MB) option in the drop-down menu. 

 

 6. Click the Next button. 

  You have successfully compiled a DVD-Video and can now burn this compilation. 

See also 

  Compilation Screen →13 

6.2 Compiling Blu-ray Video Disc 
With Nero Express you can burn a BDMV-Video disc made up of BDMV (= Blu-ray Movie) 

files from your hard drive. You can play your burned BDMV-Video on almost all Blu-ray 

players. 

You can use Nero Express to burn a BDMV-Video if the complete folder structure is already 

available. 

 

 

In Nero Express it is not possible to convert video files to DVD-Video, an AVCHD 

video, or a BDMV-Video. Converting video files to DVD-Video, to AVCHD video, 

or BDMV-Video is possible in Nero Video for example. Nero Video is included in 

the full version of Nero 2015. More information about Nero Video is available on 

the Web site www.nero.com, and more information about video editing is 

available in the separate Nero Video manual. 

 

http://www.nero.com/
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To compile a BDMV-Video disc, proceed as follows: 

 1. Click the Videos menu icon in the Nero Express start screen. 

 The video options are displayed. 

 2. Click the BDMV Files option. 

 The BDMV Files compilation screen is displayed. 

 
BDMV files compilation screen 

 3. Click the Add button. 

 The Add files and folders window is opened. 

 4. Select the BD-Video files that you would like to add to the compilation and click the Add 

button. 

 5. Click the Close button. 

 The BD-Video files are added to the compilation and are displayed in the compilation 

screen. 

 

 

Files and Folders 

The BDMV-Video contains different folders. Only certain files are allowed in an 
individual folder. If you only have individual files, you must allocate the right files 
to the specific folder: 

\BDMV\index.bdmv 
\BDMV\MovieObject.bdmv 
\BDMV\PLAYLIST\*.mpls 
\BDMV\CLIPINF\*.clpi 
\BDMV\STREAM\*.m2ts 
\BDMV\AUXDATA\sound.bdmv 
\BDMV\AUXDATA\*.otf 
\BDMV\BDJO\*.bdjo (these files are optional; however, the folder must be 
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available) 

Also, the folders \BDMV\META, \BDMV\JAR and \CERTIFICATE must be 
available but may remain empty. 

If the folder \BDMV\BACKUP is available, it contains a copy of the files 
index.bdmv, MovieObjects.bdmv and the folders PLAYLIST, CLIPINF and BDJO. 

 

 6. Click the Next button. 

  You have successfully compiled a BD-Video and can now burn this compilation. 

6.3 Compiling AVCHD Video Disc 

With Nero Express you can burn an AVCHD video disc made up of AVCHD video files from 

your hard drive or camcorder. The AVCHD video disc can be burned to a DVD as usual, or 

to a Blu-ray Disc. Burning to a Blu-ray Disc has the benefit that it offers more space than a 

DVD. 

AVCHD video on DVD is compatible to the specification of a Blu-ray Disc. However, 

playback is not guaranteed on all Blu-ray players. 

You can use Nero Express to burn an AVCHD video disc if the complete folder structure 

including premastered files is already available. 

 

 

In Nero Express it is not possible to convert video files to DVD-Video, an AVCHD 

video, or a BDMV-Video. Converting video files to DVD-Video, to AVCHD video, 

or BDMV-Video is possible in Nero Video for example. Nero Video is included in 

the full version of Nero 2015. More information about Nero Video is available on 

the Web site www.nero.com, and more information about video editing is 

available in the separate Nero Video manual. 

 

To compile an AVCHD video disc, proceed as follows: 

 1. Click the Videos menu icon in the Nero Express start screen. 

 The video options are displayed. 

 2. Click the AVCHD(TM) Files (BD) or AVCHD(TM) Files (DVD) option. 

 The AVCHD(TM) Files compilation screen is displayed. 

http://www.nero.com/
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AVCHD (TM) Files compilation screen 

 3. Click the Add button. 

 The Add files and folders window is opened. 

 4. Select the AVCHD video files that you would like to add to the compilation and click the Add 

button. 

 5. Click the Close button. 

 The AVCHD video files are added to the compilation and are displayed in the 

compilation screen. 

 6. Click the Next button. 

  You have successfully compiled an AVCHD video disc and can now burn this 

compilation. 
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7 Loading a Disc Image or Saved Project 

With Nero Express you can burn a disc from a disc image or compilation that you have 

previously saved on the hard drive. 

To load an image file or a saved compilation for the burn process, proceed as follows: 

 1. Click the Image, Project, Copy menu icon in the Nero Express start screen. 

 The copy and disc image options are displayed. 

 2. Click the Disc Image or Saved Project option. 

 The Open dialog window is opened. 

 
 3. Select the image file (*.nrg, e.g.) or saved compilation you want and click the Open button. 

 The selected file loads and the Final Burn Settings screen is displayed. 

  You have successfully loaded the image file or compilation and can now burn it. 



LightScribe 

 

 
Nero Express 45  

8 LightScribe 

Using Nero Express and a LightScribe recorder you can create or load labels that you can 

burn onto the label side of CDs/DVDs in the LightScribe recorder. The function is available 

as a separate Print LightScribe Label option in the start screen or can be integrated as an 

intermediate step into the creation and burn process of a project. 

 

 

This function is only available in the full version of Nero Express that is included in 

Nero 2015. You can always upgrade at www.nero.com to get the full version with 

all the functions. 
 

 

 

This function is only available in recorders that support LightScribe technology. 

 

See also 

  LightScribe Settings →80 

8.1 Printing LightScribe Label 

To create and print a LightScribe label for your CD/DVD, proceed as follows: 

 1. Select the LightScribe recorder you want to use in the Recorder section of the extended 

area in the start screen. 

 2. Insert a blank LightScribe disc into the LightScribe recorder with the label side facing down. 

 The Print LightScribe Label menu icon in the Nero Express start screen is displayed. 

 
LightScribe Label start screen 

http://www.nero.com/
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 3. Click the Print LightScribe Label menu icon. 

 The Print LightScribe Label option is displayed. 

 4. Click the Print LightScribe Label option. 

 The Disc Label screen is displayed. 

 
Disc Label screen 

 5. Create a label according to your requirements. 

 

 

The interface in the Disc Label screen works on the same principle as Nero 

CoverDesigner. Basically, it is irrelevant whether you print the label on paper or 

directly onto an appropriate disc. 

Please see the separate Nero CoverDesigner user manual for full instructions on 
how to make professional looking covers and labels. 

 

 6. Click the Next button. 

 The LightScribe Print Properties screen is displayed. 

 7. Add to the required values in the input fields and enable the option button for the desired 

print quality. 

 8. Click the Print button. 

 The printing process begins. You can follow the process status in the status bar. As 

soon as printing is finished, the Nero – LightScribe dialog appears and displays a 
message about the result of the printing process. 

 9. Click the OK button. 

 10. Click the Next button in the LightScribe Print Properties screen. 
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  You have successfully created and printed a LightScribe label according to your 

requirements and can now continue by selecting another option from the final screen 
or by exiting Nero Express. 
It is possible to burn the label several times to the same LightScribe disc. The 
printed labels will be aligned. This darkens the label and often improves the quality. 
It is also possible to extend the label with new elements in an additional burn 
process. Note to save the created label if you want to use it once again. 

 

 

Burning LightScribe label Within the Compilation 

To integrate the creating and burning of a LightScribel label in your compilation 
project, enable the Always print LightScribe label check box in the Options. 
The Disc Label screen will then be displayed after you have compiled your 
project (as long as the LightScribe recorder is selected). The label print process 
will be executed after burning of the data side. 

 

See also 

  LightScribe Print Properties Window →47 

  Final Screen →68 

  LightScribe Settings →80 

8.2 LightScribe Print Properties Window 
You can customize the print properties of your LightScribe label to suit your requirements in 

the LightScribe Print Properties window. 

 
LightScribe Print Properties window 
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The following options are available: 

Area 

Print contrast 

Adjusts the desired print quality. 

This option button is set to Normal by default. 

Input field 

Number of copies 
Defines the number of copies you require. 

Drop-down menu 

Drive 

Defines the desired recorder. 

Available only if multiple LightScribe recorders are 

available. 

Check box 

Automatically shut down the 

PC when done 

Shuts down the computer after the label has been printed 

(if possible). 

Button 

Print 
Starts printing the label. 

Button 

Preview 

Opens the LightScribe Print Preview dialog box. A print 

preview of the label is displayed here. 
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9 Labelflash 

If you have a Labelflash recorder, you can print a label on the label and/or data side of the 

Labelflash DVD. A Labelflash DVD has a special layer between the top and bottom layers; 

this layer can be heated by the laser in the recorder so that images and text can be printed 

on the DVD.  

 

 

This function is only available in the full version of Nero Express that is included in 

Nero 2015. You can always upgrade at www.nero.com to get the full version with 

all the functions. 
 

 

 

The interface in the Burn Label screen works on the same principle as Nero 
CoverDesigner. Basically, it is irrelevant whether you print the label on paper or 
directly onto an appropriate disc. 

Please see the separate Nero CoverDesigner user manual for full instructions on 
how to make professional looking covers and labels. 

 

 

 

This feature is only available in recorders that support Labelflash technology. 

 

 

9.1 Burn Label Window 
In the Burn Label window you can create or load a label and write it on a Labelflash DVD. 

Information on the selected printing quality and rotation speed is displayed on the right-hand 

side of the screen. Under Disc type you can see whether the blank disc has been inserted 

with the label or data side. Either the Labelflash or the DiscT@2 logo is displayed in the 

Burn Label window depending on which side is inserted. 

http://www.nero.com/
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Burn Label Window 

 

The following configuration options are available in the Burn Label window: 

Input field 

Inner Radius 
Defines the distance between the label and the inner edge. 

Input field 

Width 
Defines the width of the print area. 

Button 

Change 

Opens the Labelflash Print Properties window. 

This is where you can change the printing quality and the contrast 

level and display the changes made directly in the print preview. 

Button 

Preview 

Opens the Print Preview window that shows how the label should 

appear on the Labelflash disc. 

Selection list 

Label templates 

Contains a selection of different templates for designing the label. 

You can continue to edit and customize a selected template. 

Button 

Burn 
Starts the burn process. 



Labelflash 

 

 
Nero Express 51  

 

Button 

Cancel 
Cancels the procedure and closes the window. 

  

 

 

If you are creating a DiscT@2, Nero Express displays only the available print area 
for creating the label by default, i.e. the area on the data side of your DVD that is 
not already taken up by data. You cannot increase the radius of the print area. 

 

9.2 Printing Labelflash Labels and DiskT@2 
Basically, it is irrelevant whether you print on the label or the data side when creating labels. 

The label is actually printed outside the normal burn process. 

 

 

You can print on the label side of the DVD at any time.  

We recommend that you print on the data side first when you have burned the 
compilation. It is not possible to burn data on a printed data side. When you insert 
a DVD on which data has already been burned, Nero Express automatically 
identifies the space that is still available on the data side and on which you can 
print. 

 

To print a Labelflash label on the label side or a DiskT@2 on the data side of your DVD, 

proceed as follows: 

 1. If you want to print a Labelflash label on the label side, insert a blank Labelflash disc into the 

recorder with the label side facing down. 

 The Burn Label window is opened with the Labelflash logo.  

 2. If you want to print a DiskT@2 on the data side, insert a blank Labelflash disc with the data 

side facing down in the recorder. 

 The Burn Label window is opened with the DiskT@2 logo.  

 3. Create a label according to your requirements or open a label that you have already created 

with Nero CoverDesigner. 

 

 

The interface in the Burn Label window and creation of a label work on the same 
principle as Nero CoverDesigner. See the separate Nero CoverDesigner manual 
for full instructions on how to create professional looking covers and labels. 

 

 4. If you want to change the area in which the label is printed, change the print area 

accordingly using the input fields Inner Radius and Width. 

 5. If you want to view or change the print properties: 

 1. Click the Change button. 

  The Labelflash Print Properties window is opened. 
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 2. If you want to change the printing quality, select a quality level from the Print quality 

profile drop-down menu. 

 3. If you select the User defined entry from the Print quality profile drop-down menu, you 

can change the contrast level and the rotation speed. 

 4. Click the OK button. 

  The Labelflash Print Properties window is closed and the changes are accepted. 

 
Labelflash Print Properties 

 6. Click the Burn button.  

 The labeling procedure starts and the Labelflash - printing or DiscT@2 - printing 

window is opened. The window shows the estimated printing time and the print progress. 
When printing is complete, a message window is opened informing about the successful 
print process. 

 7. Click the OK button. 

 The message window is closed and the disc ejected. 

  You have successfully printed a label. 
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10 Burn Compilation 

10.1 Recorder Settings 
If multiple recorders are installed, you can select the recorder that you want to use for 

burning from the Recorder drop-down menu. Immediately before burning a project, you can 

change the recorder you selected again in the Final Burn Settings window. 

 

 

Labelflash recorder 

If a Labelflash recorder is installed on your computer, you can select it to create 
and print Labelflash DVD labels in Nero Express. The function is available as a 
separate Burn Label menu icon in the extended area of the start window. 

 

 

 

LightScribe recorder 

If a LightScribe recorder is installed on your computer, you can select it to create 

and print LightScribe CD/DVD labels in Nero Express. The feature is available as 
a separate Print LightScribe Label option in the start screen or can be 
integrated as an intermediate step into the creation and burn process of a project. 

 

 

 

Burn functions are limited in Nero Express Essentials. You can always upgrade at 

www.nero.com to get the full version with all the functions. 

 

In addition to the installed recorders, Nero Image Recorder is also available in Nero Express. 

Nero Image Recorder can be used to create and save an image file to burn later. In order to 

use Nero Image Recorder, you can select the Use Nero Image Recorder check box in the 

extended area of the start screen. 

 

 

Please note that Nero Image Recorder can only be activated in the extended area 

of the start screen. 
 

 

 

The Image Recorder is also suitable for creating an image of a disc type not 
supported by the connected recorder. For example, you can therefore create a 
DVD image without having installed a DVD recorder. You can then write the 
image to a disc at any time. 

 

 

10.2 Burn Process 
To select one of the available recorders, to define the burn settings for your project 

according to your requirements, and to start the burn process, proceed as follows: 

 1. Compile a project of your choice. 

 2. Click the Next button. 

http://www.nero.com/
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 The Final Burn Settings screen is displayed. 

 3. Insert a suitable blank disc in the selected drive. 

 4. Select the recorder you want from the Current recorder drop-down menu. 

 5. Add to the desired values in the input fields as necessary and select the required check 

boxes. 

 6. Add to the desired settings in the extended area. 

 7. Click the Burn button. 

 The Burn Process screen is displayed and the burn process starts. You can follow the 

process status in the status bar. 

 If the SecurDisc Surface Scan check box is selected, the SecurDisc Surface Scan 

Results window is opened. 

 Nero Express starts with the surface scan. The results are displayed in realtime.  

 When the burn process has finished, a message window is opened. 

 8. Click the OK button. 

 9. If you would like to save a log of the burn process, click the Save button. 

 10. Click the Next button. 

  You have successfully burned a project and can now continue by selecting another 

option from the final screen or by exiting Nero Express . 

10.3 Creating an Image File 
With Nero Express and the Image Recorder you can create disc images from every 

compilation. The NRG image file format can always be selected whereas the ISO image file 

format can only be selected from certain compilation types. Nero Express only enables the 

possible image file formats. 

The NRG image file format was developed by Nero. In contrast to ISO, NRG can be created 

from every disc and compilation type. This means that even Audio CDs or multisession discs 

can be saved as an NRG image file. 

 

 

This function is only available in the full version. You can always upgrade your 

Essentials version at www.nero.com to get the full version with all the functions. 
 

 

 

Nero Image Recorder must be activated before it appears in the drop-down 
menu. 

 

To set the burn settings according to your requirements and to save your project as an 

image file to the hard drive using the Image Recorder, proceed as follows: 

 1. Compile a project of your choice. 

 The Final Burn Settings screen is opened. 

 2. Select the Image Recorder option from the Current Recorder drop-down menu. 

http://www.nero.com/
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 3. Add to the required values in the input fields. 

 4. Add to the required settings in the extended area as necessary. 

 5. Click the Burn button. 

 The Burning Process screen is displayed and the Save Image File dialog box is 

opened. 

 6. Enter a name for your image file in the File Name input field. 

 7. Select the desired storage location in the navigation tree and click the Save button. 

 The burn or save process starts. You can follow the process status in the status bar. As 

soon as the burn or save process is finished, a window is opened and displays a 
message about the result of the burn process. 

 
Burn progress window 

 8. Click the OK button. 

 9. If you would like to save a log of the burn process, click the Save button. 

 10. Click the Next button. 

  You have successfully saved a project with Nero Image Recorder and can now 

continue by selecting another option from the final screen or by exiting Nero 
Express. 

10.4 Burn Settings 
In the Final Burn Settings screen, you can define the burn settings to suit your 

requirements, use Nero Image Recorder to save a project to the hard drive as an image file 

or start the burn process. 
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Final Burn Settings screen 

The following configuration options are available in the Final Burn Settings screen: 

Button 

Options 

Opens the Recorder Information window. You will find additional 

information here on the selected recorder and the media types that 

can be burned using it. Additional options can be enabled/disabled. 

In some recorders, you can change the Book Type settings. 

Not available for Audio CDs. 

Input field 

Disc name 

Defines the name of the CD/DVD. 

Not available for Audio CDs. 

Input field 

Title (CD TEXT) 

Defines the title of the Audio CD if CD Text is supported. 

Available for Audio CDs only. Only Latin characters can be displayed 

as CD Text. CD Text can only be written in disc-at-once mode. 

Input field 

Artist (CD TEXT) 

Defines the artist on the Audio CD if CD Text is supported. 

Available for Audio CDs only. Only Latin characters can be displayed 

as CD Text. CD Text can only be written in disc-at-once mode. 

Input field 

Number of copies 

Defines the number of copies you require. 

Not available when saving with Nero Image Recorder. 

Check box 

Verify data on disc 

after burning 

Compares the burned data to the original data. With compilations of 

multisession discs only the data that was added during the last burn 

process is compared. 

Not available when saving with Nero Image Recorder. 
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Check box 

SecurDisc Surface 

Scan 

Checks the quality of the disc surface after the burn process. You 

can use this option particularly when burning backups or discs that 

have to be archived to ensure that the disc surface does not have 

any issues and that burning went well. 

This check box is only active if the Verify data on disc after 

burning check box is selected. 

Check box 

Allow files to be 

added later 

(multisession disc) 

Enables the option to write additional files to the disc. The disc is not 

finalized. Multisession discs do not have to be written in a single burn 

process. You can burn projects repeatedly to a disc until it is 

completely burned. 

Only available for data discs. 

  

 

10.4.1 Extended Area (Burn Settings) 

You can access additional burn settings in the extended area of the Final Burn Settings 

screen by clicking the  button in the left margin of the window. 

The following setting options are available: 

Button 

Saves the active project 

Opens the Save As dialog box. 

You can save your compilation here. 

Selection list 

Writing speed 

Defines the speed at which the disc is burned. Only the burn 

speeds that are supported by the selected recorder are 

displayed. 

Not available when saving with Nero Image Recorder. 

Selection list 

Write method 

Defines the Disc/Session-at-once or Track-at-once write 

method. 

Using the disc-at-once method the entire disc can be burned 

without the write laser having to stop. With the track-at-once 

method the laser turns off after each track. 

Available for CD compilations only. By default DVDs are 

burned using the disc-at-once method. 

Check box 

Determine maximum 

transfer rate 

Checks how fast the compiled data can be accessed and 

reduces the selected writing speed if necessary. This prevents 

a buffer underrun. 

Recorders with a feature to prevent buffer underruns do not 

require a speed test. Current recorders mostly have such a 

feature. 

Not available when saving with Nero Image Recorder. 
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Check box 

Simulation 

Performs all steps in the burn process without using the laser 

beam. We recommend running a simulation if you are 

decompressing data before burning, e.g. when burning an 

Audio CD from MP3 files. You can assume that if simulation is 

successful, the burn process will also be successful. 

Not available when saving with Nero Image Recorder. 

Check box 

Write 

Starts the actual physical burn process (e.g. after a 

simulation).  

This check box is selected by default. 

Check box 

Automatically shut down 

the PC when done 

Automatically shuts down the PC after the burn process has 

ended. 

  

Check box 

Remove silence at end of 

*.cda tracks 

Removes silence from the end of an audio file. This check box 

is selected by default. Audio data is stored in blocks even if 

you do not always finish at the end of a block limit. The last 

block is filled with silence when needed. 

To avoid unwanted effects set the pause length to 0 when 

clearing this check box (to set the pause length see Track 

Properties Tab→ 25). 

Available for Audio CDs only. 

  

Check box 

Increase compatibility of 

MPEG-4 video files with 

MPEG-4 compliant DVD 

players 

If the check box is selected, Nero Express looks for FourCC 

codes in AVI files during the burn process and replaces them. 

The original files are not modified. The compatibility of MPEG-

4 video files ("DIVX") with MPEG-4 compliant DVD players can 

be increased. 

Only available if your project includes videos in AVI format. 

  

 

 

Audio CDs should always be burned using the disc-at-once method. This entry is 

selected by default. 

 

 



Copying a Disc 

 

 
Nero Express 59  

11 Copying a Disc 

11.1 Methods of Copying 
Nero Express can be used for copying discs. There are two methods for this: 

 

  On-the-fly 

  Copy Over Image 

Each method has advantages and disadvantages which will depend on your requirements. 

11.1.1 On-the-fly Copying 

When using the on-the-fly method, insert the original disc into a drive and a recordable disc 

into the drive. The original disc in the drive is copied immediately without any time delay to 

the blank disc in the recorder. The on-the-fly method allows you to copy discs very quickly, 

and does not require any additional space on the disc. 

In order to be able to use the on-the-fly method, you will need at least two drives: one for 

reading the disc and a disc burner for writing. The following requirements apply to the read 

drive and disc burner: 
 

  The disc burner must feature buffer underrun protection, or the drive must be capable of 

delivering the data sufficiently quickly. The read speed should be at least twice as fast as 

the write speed.  

  The read drive must be capable of delivering information on the number and type of 

sessions, otherwise Nero Express may not be able to produce an exact copy.  

If you want to copy Audio CDs, we recommend the copy image method because the quality 

of the read audio files can suffer depending on the drive.  

11.1.2 Copy Over Image 

With the copy over image method, an image of the original disc is saved to a file first. The 

image file is then burned to a blank disc. Copying using copy over image takes longer, but it 

often produces better results. 

You must have sufficient storage space to use the copy over image method. 

The copy over image method is particularly suitable in the following situations: 
 

  Only one drive is available. 

  You would like to make several copies of the same disc. 

  You think it likely that read errors may have occurred on the source CD (for example 

because it is scratched). 

  You attach importance to the best possible reproduction (particularly in relation to index 

positions and the quality of Audio CDs). 
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11.2 Copying a Disc 
With Nero Express you can copy a disc. That means you make an exact copy of a source 

disc and burn it to a target disc. If your source disc is an Audio CD, for instance, your copy 

will be an Audio CD as well. Depending on your installed burner, you can copy CDs, DVDs 

or Blu-ray Discs. The target disc must be the same disc type as the source disc - you can 

copy a DVD only to a DVD, for example. In any case, Nero Express will give you a message 

when the disc type do not fit. 

 

 

If you are not in possession of the copyright for the relevant disc and do not have 

authorization from the owner of the copyright, unauthorized copying of discs 

violates national and international legislation. 
 

 

 

Some discs are copy-protected and cannot be copied. If you are not sure whether 
your disc can be copied, activate simulation before commencing the actual 
physical burn process. 

 

To copy a disc, proceed as follows: 

 1. Click the Image, Project, Copy menu icon in the Nero Express start screen. 

 The corresponding copy options are displayed. 

 2. Click the Copy Disc option. 

 The Select source and destination screen is displayed. 

 
Source and Destination 

 3. Make the desired settings in this screen and, if required, in the extended area of the 

window. 

 4. If you want to copy discs using the Image Copy method: 
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 1. Clear the Quick copy box. 

 2. Insert the disc that you want to copy into the recorder. 

 5. If you want to copy discs using the on-the-fly method: 

 1. Select the Quick copy check box. 

 2. Select the Source drive and the Destination drive. 

 3. Insert the disc that you want to copy into the selected drive. 

 4. Insert a blank disc into the target drive. 

 6. Click the Copy button. 

 If you are copying via the drive, the copy process starts. If you are using Nero Image 

Recorder, the Save Image File window is opened. 

 7. Enter a name for your image file in the File Name input field. 

 8. Select the relevant storage location in the Save to navigation tree and click the Save button. 

 The copy and/or save process starts. You can follow the process status in the status bar. 

If you are using a single drive for copying, you will be prompted to remove the source 
disc and to insert a suitable blank disc after the image file has been written. The burn 
process then starts automatically. 

 9. Click the Next button. 

  You have successfully copied a disc and can now continue by selecting another 

option from the final screen or by closing Nero Express. 

See also 

  Final Screen →68 
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11.3 Methods and Settings 

 
Source and Destination screen 

The following configuration options are available in the Source and destination screen: 

Selection list 

Source drive 

Defines the drive from which the source information is read. 

Insert the disc that you want to copy into the drive. 

Selection list 

Destination drive 

Defines the destination drive. 

Insert a blank disc into this drive. 

Button 

Info 

Opens the Recorder Information window. 

This contains information on the selected destination drive. 

Check box 

Quick copy 

Enables direct copying from the source to the destination 

drive. Data is not buffered on the hard drive during this 

process. 

The option On-the-fly is only available if there are at least two 

drives connected (does not apply for Nero Image Recorder). If 

this check box is not selected, an image file will be created 

first, which is then burned. 

Selection list 

Write speed 

Defines the speed at which the disc is burned. Only the burn 

speeds that are supported by the selected recorder are 

displayed. 

Not available for Nero Image Recorder. 
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Input field 

Number of copies 
Defines the number of copies you require. 

Check box 

Verify data on disc after 

burning 

Verifies whether the burned data is identical to the original 

data. 

Not available for Nero Image Recorder. 

Display field / Button 

Image file 

Defines the folder where the image file is stored. You can 

change the name of the image file and target folder. 

Not available for Nero Image Recorder. 

  

The following configuration options are available in the extended area: 

Check box 

Read all subchannel 

data 

Reads all subchannel data during copying. Subchannel data is 

used to save additional information, e.g. CD Text or the lyrics of 

a karaoke CD. Select this check box when copying an Audio 

CD or a karaoke CD.  

The burner has to be capable of reading all the subchannel 

data. 

Check box 

Determine maximum 

transfer rate 

Checks how fast the compiled data can be accessed and 

reduces the selected writing speed if necessary. This prevents 

a buffer underrun. 

Recorders with a feature to prevent buffer underruns do not 

require a speed test. Current recorders mostly have such a 

feature. 

Not available when saving with Nero Image Recorder. 

Check box 

Simulation 

Performs all steps in the burn process without using the laser 

beam. You can assume that if simulation is successful, the burn 

process will also be successful. 

Not available for Nero Image Recorder. 

Check box 

Write 

Starts the actual physical burn process (e.g. after a simulation).  

This check box is selected by default. 

Check box 

Automatically shut 

down the PC when done 

Automatically shuts down the PC after the burn process has 

ended. 
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11.4 Copy an Audio CD 
The CD Information window is displayed after you have started copying an Audio CD. Here, 

you can check exactly what metadata will be written on the Audio CD. 

 
CD Information window 

 

Metadata about the Audio CD is available from different sources: The Audio CD's own CD 

TEXT, Gracenote Media Database and your local database: 
 

   Many Audio CDs contain CD TEXT which includes metadata such as the title of the 

CD, the name of an audio file or the name of the artist. 

   The Gracenote Media Database holds such metadata about many Audio CDs. With 

Gracenote MusicID Nero Express can identify music files and access metadata from the 

Gracenote Media Database. 

   The local database is stored on your PC and contains information for each Audio 

CD that was ripped or copied. The local database is useful, when you change title or 

artist but don't want to send the changes to Gracenote (because the changes make 

sense only for you, for example, or you don't have an Internet connection at the 

moment). 

During the copy process, Nero Express requests metadata from the Audio CD's own CD 

TEXT, from the Gracenote Media Database, and from your local database and displays 

them, if available. You can select which metadata will then be written to the Audio CD during 

the copy process. You can also change the metadata or create new Audio CD metadata. 
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Another useful feature is that you can start creating a cover for this Audio CD with Nero 

CoverDesigner, the metadata will be taken over. 

The following setting options are available: 

CD list 

Shows the available Audio CD information. CD TEXT and metadata 

from the Gracenote Media Database are requested and displayed, if 

available. If the Audio CD contains no CD TEXT, at least the track 

titles and the duration are displayed. 

You can edit the information by double-clicking the text display [F2]. 

Tracklist of the 

currently selected 

CD 

Shows the audio tracks of the Audio CD. Here, you can see in detail 

which information will be used for the copied Audio CD. 

You can edit the information by double-clicking the text display [F2]. 

Button 

Create Cover 

Opens Nero CoverDesigner. Information such as title, track number, 

and names of the audio files is added to the document data. 

Check box 

Always use 

suggested CD 

information and 

never show this 

message again 

If you select this check box, Nero Express will always adopt Audio 

CD information automatically. First, CD TEXT is used. If no CD 

TEXT is available on the Audio CD, a request is sent to Gracenote 

and Gracenote metadata is used. Applying information automatically 

has the advantage that copying is executed faster, but the downside 

is that you do not know exactly what information is copied. 

Button 

OK 

Continues copying the Audio CD using the selected Audio CD 

metadata. 

  

 

 

Music recognition technology and related data are provided by Gracenote®. 
Gracenote is the industry standard in music recognition technology and related 
content delivery. For more information, please visit www.gracenote.com. 

 

 

http://www.gracenote.com/
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12 Erase Rewritable Disc Window 
Nero Express can be used to erase rewritable discs, i.e. discs with the RW specification, as 

long as your recorder supports this feature. Two erase methods are available for this 

purpose: 

Quick erasing does not remove the data physically from the disc, but instead only makes it 

inaccessible by erasing the references to existing content. The data can be restored! 

Full erasing removes the data from the disc by overwriting it with zeros. The contents cannot 

be restored with conventional methods. Repeated full erasing increases the probability that 

third parties will not be able to reconstruct the contents. 

 
Erase Rewritable Disc window 

 

The following configuration options are available in the Erase Rewritable Disc window: 

Selection list 

Select recorder 
Defines the desired recorder. 

Check box 

Use multiple recorders 
Simultaneously erases CDs/DVDs in multiple recorders. 

Selection list 

Select the erase 

method to be used 

Defines the erase method. Two options are available: 

The Quick-erase rewritable disc method does not physically 

erase all data from the disc, but only the references to the 

contents. The disc will appear to be empty even though the data 

is still physically available. Erasing a disc using this method 
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takes between one and two minutes. 

The Full-erase rewritable disc method physically erases all 

data from the disc. The contents cannot be restored with 

conventional methods. Repeated full erasing increases the 

probability that third parties will not be able to reconstruct the 

contents. Erasing the disc using this method takes longer than 

the other method, depending on the type of disc involved. 

Selection list 

Erase speed 
Defines the erase speed. 

Button 

Erase 
Starts the erase process. 

Button 

Cancel 
Cancels the action and closes the window. 
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13 Final Screen 
Once you have successfully concluded the burn or save process with Nero Express, the final 

screen is displayed with the options Burn same project again, New project, and Save 

Project. You can select one of these options to continue working with Nero Express or you 

can click the  button to exit the program.  

The following setting options are available 

Entry 

Burn the same 

project again 

Returns to the Final Burn Settings screen. 

You can burn the same project again with the same or different 

settings. 

Entry 

New project 

Opens the Nero Express start screen. 

You can create a new project here. 

Entry 

Save project 

Opens the Save As window. 

You can save the current project if you want to access it again later. 

Entry 

Nero 

CoverDesigner 

Opens Nero CoverDesigner. 

Please see the separate Nero CoverDesigner user manual for full 

instructions on how to make professional looking covers and labels. 

Entry 

Burn Labelflash 

Label 

Opens the Burn Label window in order to create and burn a 

Labelflash label. 

Only available if a Labelflash recorder is connected. 
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14 About Nero SecurDisc Viewer 
Nero SecurDisc Viewer is a standalone application that is part of the SecurDisc technology 

platform. SecurDisc is a technology developed by Nero and HLDS to create discs with 

special protection properties. No special hardware is needed. 

Nero SecurDisc Viewer is available as a free download at www.securdisc.net or 

www.nero.com and is also included automatically in a SecurDisc disc that is burned with 

Nero Burning ROM or Nero Express. 

Discs that are created with Nero and the SecurDisc compilation type include data integrity 

and reconstruction. Additionally the data on the SecurDisc disc can be protected against 

unauthorized access by using a password. The data can also be digitally signed. Nero 

SecurDisc Viewer allows you to copy the protected data to your hard drive and to check the 

security of the data. 

 

 

More information on SecurDisc technology can be found at www.securdisc.net. 

 

14.1 Starting Nero SecurDisc Viewer 
Nero SecurDisc Viewer is included automatically in a SecurDisc disc that is burned with Nero 

Burning ROM or Nero Express. Insert the SecurDisc disc in a drive to open Nero SecurDisc 

Viewer automatically.  

Nero SecurDisc Viewer can also be opened by double-clicking the 

NeroSecurDiscViewer.exe file. This file can either be found on the SecurDisc disc or it can 

be downloaded from www.securdisc.net or www.nero.com.  

 
Main screen 

 

http://www.securdisc.net/
http://www.nero.com/
http://www.securdisc.net/
http://www.securdisc.net/
http://www.nero.com/
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14.2 Copying Data to Hard Drive 
With Nero SecurDisc Viewer you can copy the files from the SecurDisc disc to your hard 

drive. If the files have been protected against unauthorized access, you can insert the 

password here. 

Proceed as follows: 

 1. Select the check boxes of the files you want to copy to the hard drive. 

 2. Click the Save to button. 

 If data on the SecurDisc disc is password-protected, the Password Protection window 

is opened. 

 
 

 3. Enter the password in the text box and click the Apply button. 

 An explorer window is opened. 

 4. Select the required folder and click the OK button. 

 A progress window is opened and the files are copied. As soon as the copy process is 

finished, a message is displayed to notify you. 

  The selected files are copied to the selected folder. 

14.3 Checking Data Integrity 
Nero SecurDisc Viewer can be used to check the data integrity of a SecurDisc disc by using 

the checksum feature. The data integrity check warns you if the data on a disc is at risk of 

disc decay so that you have time to back it up to another disc. 

Proceed as follows: 

 1. Click the Integrity button. 

 A progress window is opened and the integrity check is carried out. You can follow the 

progess with the status bar and the displayed messages.  

  As soon as the integrity check is finished, a message is displayed to notify you about 

the result of the check. 
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14.4 Checking Signature 
With Nero SecurDisc Viewer you can verify the authenticity of the SecurDisc disc if it is 

digitally signed. You need the public key from the distributer of the SecurDisc disc for this 

purpose. By checking the public key, Nero SecurDisc Viewer is able to confirm that the data 

is authentic and has not been manipulated. 

Proceed as follows: 

 1. Click the Signature button. 

 An explorer window is opened. 

 2. Select the public key (*.bpk) which the SecurDisc disc is signed with. 

 

 

Public key 

The creator of the SecurDisc disc has also created or selected the public key for 
the disc. The key is to be distributed by the creator of the disc, too. 

 

 3. Click the OK button. 

 The explorer window is closed and the Check window is opened.  

 The signature is checked. You can follow the progess with the status bar and the 

displayed messages. 

  As soon as the copy process is finished, a message is displayed to notify you about 

the result of the check. 
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15 Nero MediaBrowser 
Nero MediaBrowser is a tool which you can use to easily find, view and access media files 

and add them to your project. More precisely, with Nero MediaBrowser you can access a 

media library which contains all your media files that were indexed by Nero MediaHome. 

 

 

Nero MediaBrowser and the media library come with Nero MediaHome and are 
installed together. You will find further information in the Nero MediaHome 
manual. 

 

Nero MediaBrowser is designed to be accessed in several Nero applications, but is also 

available as a standalone application. 

 
Nero MediaBrowser 

 

To use Nero MediaBrowser within a Nero application, open Nero MediaBrowser via the  

button. When you double-click a media file or select it and click the Add button in Nero 

MediaBrowser, the media file will be added to your current project. 

To use Nero MediaBrowser with a non-Nero application, open Nero MediaBrowser via the 

Windows start menu or its tile, depending on your operating system. You will then be able to 

add media files to any active application by dragging the desired media file onto the 

application. When you double-click a media file in Nero MediaBrowser, it is opened in its 

default program. 



Nero MediaBrowser 

 

 
Nero Express 74  

Nero MediaBrowser features the same categories (Photos & Videos, and Music) as Nero 

MediaHome. There are different views available for each category: Clicking one of the 

entries in the upper part of the list (for example Faces) displays the same view as when 

clicking the corresponding tabs in Nero MediaHome. Also, the same scroll bar as in Nero 

MediaHome is used. This is either the standard scroll bar or the dynamic scroll bar.  

The following views are available for the Photos & Videos category, referring to the 

corresponding views in Nero MediaHome: 

All Photos & 

Videos 

Displays all photos and videos sorted in chronological order by 

creation date.  

Faces 

Displays all photos in which faces of persons have been detected 

and named listed in alphabetical order. Faces are grouped into 

stacks; you can access one of the stacks by double clicking it. 

Find Displays all existing tags enabling you to create a query. 

Album 
Displays the content of smart albums (e.g. Recently added) and 

user generated albums. 

  

The following views are available for the Music category, referring to the corresponding 

views in Nero MediaHome: 

Albums Displays all audio tracks sorted in alphabetical order by album. 

Artists Displays all audio tracks sorted in alphabetical order by artist. 

Genres Displays all audio tracks sorted in alphabetical order by genre. 

Titles Displays all audio tracks sorted in alphabetical order by title. 

Playlist 
Displays the content of smart playlists (e.g. Recently played) and 

user generated playlists. 

  

The Options window is opened when you click the  button on the upper task bar. The 

options refer directly to Nero MediaHome. 

Library 

Displays the Library settings area. 

All monitored folders are displayed in the respective Watched 

folders or drives area. If you want to add additional media folders, 

click the Add Manually button and select the desired folder from the 

navigation tree. Click the Add Automatically button to have Nero 

MediaHome perform a search for new media folders on your 

computer. To exclude certain media types (music, videos, or photos) 

from a folder, click the respective button to the right of the folder. To 

delete a folder from the application's watchlist, hover your cursor 
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over the listed folder and click the  button. 

You can also just drag files or folders to Nero MediaHome. A window 

automatically opens and asks if you want to add the folder(s) to the 

library. 

In the General area you can select to list your external playlists 

(such as iTunes) as entries in the navigation tree of Nero 

MediaHome. 
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16 Configuration Options 
You can define options for working with Nero Express in the Options window.  

 

 

Some of the functions mentioned here are only available in the full version. You 

can always upgrade your Essentials version at www.nero.com to get the full 

version with all the functions. 
 

 

 
Options Window 

 

The following tabs are available: 

Compilation Contains options for the compilation and the selection screen. 

http://www.nero.com/
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Cache Contains options for the cache. 

Font Contains selection options for the font. 

Sounds Contains selection options for sounds in connection with burn tasks. 

Expert Features 
Contains options for configuring overburning and burning.  

We recommend that you retain the default settings. 

Database 
Selects the default naming method for audio files to be saved from 

an Audio CD to the hard drive. 

Ultrabuffer Defines the size of the RAM buffer. 

Misc. 
Contains options for configuring compilations, burning, the database, 

the user interface, as well as advanced settings.  

LightScribe 

Contains options for configuring LightScribe recorders such as the 

print contrast (quality), default drive, and default template. 

This tab is only available if a LightScribe recorder has been installed. 

  

 

16.1 Compilation Settings 

The following configuration options are available on the Compilation tab: 

Check box 

Remember name of last used 

disc 

Uses the Disc name of the last compilation for a new 

compilation. 

If the check box is cleared, the Disc name is set to New 

for a new compilation. 

Check box 

Clear archive bits of written 

files during ISO refresh 

Clears the archive bit of the source file (e.g. from the 

hard disk) as soon as the burn process has finished. 

Clearing of the archive bit is of informational value and 

indicates that this file has been archived. 

If this check box is deactivated, the archive bit of the file 

remains unchanged. 

Check box 

Allow semicolons in Joliet 

names 

Allows the use of semicolons in addition to standard 

uppercase and lowercase letters and Unicode 

characters in file names in the Joliet file system. 

Check box 

Show original path with ISO 

compilation 

Lists the full path of the added files in the compilation 

screen in the Source column. 
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16.2 Cache Settings 

The following configuration options are available on the Cache tab: 

Input field 

Path for cache 

Displays the path of the Cache memory.  

You can enter the path manually or select the path in 

the browser window. 

Button 

Browse 

Opens a browser window. 

You can select a folder in which data is buffered before 

and during the burn process. 

Input field 

Minimum space on hard drive, 

which Nero should not use 

Defines the minimum storage volume on the cache drive 

that is not used by Nero Express. 

Check box 

Immediately cache files that 

have been copied from an 

optical drive 

Saves files that have been added to the compilation 

from a source disc in a temporary directory. 

If you clear this check box then you have to insert the 

original source disc during the burn process. 

  

 

16.3 Expert Features 

The following configuration options are available on the Expert Features tab: 

Check box 

Enable Disc-at-once CD 

overburning 

Enables the option that CDs can be overburned. 

Drop-down menu / Input field 

Absolute/Relative maximum 

overburning size 

Defines how much a CD can be overburned. 

Check box 

Enable DVD overburning 
Enables the option that DVDs can be overburned. 

Drop-down menu / Input field 

Maximum DVD size 
Defines how much a DVD can be overburned. 

Check box 

Enable generation of short 

lead-out 

Enables the option to write additional data to your CD. 
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Check box 

Do not eject the disc after the 

burn is complete 

Enables the option that your disc remains in the 

recorder and is not ejected when the burn process is 

finished. 

Check box 

Enable all Nero supported disc 

types for the Image Recorder  

Enables the option that all supported recorder formats 

for the Image Recorder are available. 

It is now possible to create compilations that the 

installed recorder cannot burn. For instance, you can 

create a Blu-ray compilation without a Blu-ray recorder 

and create an image file with Nero Image Recorder. 

Check box 

Enable automatic renaming of 

AVCHD file extensions 

Renames the file extensions to fit the AVCHD 

specifications. AVCHD content on optical discs requires 

four letter extension to be detected as an AVCHD disc. 

Area 

Nero burn functions in the 

context menu 

Allows Nero Express to be started from the shell context 

menu. The shell context menu offers various pertinent 

information and is opened by clicking a file or folder with 

the right mouse button in the Windows Explorer. 

Area / Button 

Restore 
Resets all settings back to the original factory settings. 

  

 

 

Overburning 

Overburning means writing more data on the disc than originally intended. It is 
achieved by reducing the lead-out area to a few seconds, which is sufficient in 
most cases. However, this violates the CD standard and may result in recording 
and playback errors (depends on the used recorder). 

 

16.4 Ultrabuffer Settings 

The following configuration options are available on the Ultrabuffer tab: 

Selection list 

Method 

Defines the memory capacity that Nero Express uses as 

a RAM buffer. 

The ultrabuffer is a second memory that enhances the 

physical buffer in the recorder.  

Input field 

Data buffer size 

Defines the memory capacity that can be manually 

entered. 

The input field is only enabled when Manual 

Configuration is selected in the selection list. 

  

 



Configuration Options 

 

 
Nero Express 80  

16.5 LightScribe Settings 

The following configuration options are available on the LightScribe tab: 

Area 

Print contrast 
Adjusts the desired print quality. 

Selection list 

Default LightScribe drive 
Selects the drive with the LightScribe recorder. 

Selection list 

Genre 
Specifies the genre. 

Selection list 

Current template 
Defines a template for labels. 

Selection list 

Default print resolution (DPI) 
Adjusts the desired print resolution. 

Check box 

Always print LightScribe label 

Offers the option to create and burn a LightScribe label 

automatically when burning with a LightScrive recorder. 

This tab is only available if a LightScribe recorder has 

been installed. 
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17 Glossary 

AIFF  
The Audio Interchange File Format is an uncompressed audio file format from Apple® and 

represents a sort of counterpart to the WAV format from Microsoft. Files are larger than 

when using a compressed format, but the quality is higher. AIFF compressed is the 

compressed variation.  

Archive Bit  
Archive bits are used to identify files that have been edited. A file is only resaved during the 

next backup process if it was edited (and an archive bit is thus reset). 

Audio CD 
An Audio CD can contain up to 74 minutes of audio sequences and individual tracks in hi-fi 

quality. The storage capacity is 747 MB at a sample depth of 16 bit and a scan rate of 44.1 

kHz. 

AVCHD 
AVCHD is an HD capturing format for camcorders. It is used for DVDs but compatible to Blu-

ray Discs. 

Block 
A block refers to the smallest information unit on a CD-ROM or hard drive that is 

addressable in one access and that is indicated in bits or bytes. Several blocks are 

combined into a sector. 

Book Type  
The book type defines the specification (e.g. DVD-, DVD+, DVD-ROM) of a DVD. In order to 

ensure correct playback, the DVD specifications are defined in books so that all media can 

be read correctly. The specifications are defined in the so-called Rainbow Books, which are 

distinguished by means of their color (e.g. Yellow Book).  

Buffer 
A buffer refers to temporary memory that records and delivers data that cannot be processed 

immediately as required. The buffer also allows for continuous data flow. 

Buffer Underrun  
A buffer underrun is an interruption in the data flow in the internal memory (e.g. of the 

recorder). A buffer underrun results from an interruption in the data flow to the internal buffer. 

The buffer continues to deliver data until it is finally empty. When recording, data is fed 

continuously to the recorder's buffer in order to keep a steady flow of data. If the steady flow 

of data is interrupted, the media becomes unusable. Most modern recorders have a 

protective mechanism against buffer underruns. 
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Cache  
Cache is a faster buffer that is used in various areas of a computer to access larger data 

volumes faster. Cache ensures a continuous flow of data.  

CD-R  
Compact Disc-Recordable is a technology for write-once media. The Orange Book standard 

defines the storage of audio data and other computer-readable data.  

Disc-At-Once  
Disc-At-Once refers to a method in which the laser in your disc burner burns the disc in one 

pass without turning off and on between each track. This method is best when recording 

Audio CDs you would like to play in your home or car stereo.  

Frame  
With an Audio CD, 75 sectors provide one second of played music. One sector consists of 

up to 98 frames; one frame contains 24 data bytes and 9 control bytes. Similarly, "frame" 

describes a full screen in television and video technology. Two successive half images result 

in a full screen within a second due to interlacing.  

Image  
An image refers to a single file on the hard drive that contains the image of a complete disc. 

A disc image can be used to create exact copies on media at a later point in time if problems 

occur during the write process or if no recorder is connected to your PC. The image requires 

as much free space on the hard drive as the contents of the original disc take up.  

Joliet 
Joliet refers to an extension of the ISO-9660 standard for file names. Joliet was designed by 

Microsoft in order to represent more characters. The file name can be up to 64 characters 

long and contain the letters A-Z, a-z, umlauts, as well as characters from Chinese, 

Japanese, and Korean. 

Label  
A label refers to a label on a disc. Some drives, e.g. drives that use LightScribe or Labelflash 

technology, can transfer labels directly to special media.  

Labelflash  
Labelflash is a technology with which pictures and texts can be burned on the label or data 

side of a disc with a laser.  

LightScribe  
LightScribe is a technology with which pictures or texts can be burned on the label side of 

discs with a laser.  
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MP3  
The MPEG-1 Audio Layer 3 audio format is used to reduce the size of audio files to a 

fraction of their original size (factor 1:10) with little loss of quality. You can estimate about 1 

MB per minute as opposed to 10 MB for the original files. This value and the quality can vary 

depending on the complexity of the audio signal. The bit rate used can be used as a 

measure of quality. The higher the bit rate, the better the quality, but also the more memory 

required. 

mp3PRO  
mp3PRO is an MP3 codec that compresses audio files even more but in lower bit rates and 

better quality. 64 kBit/s in mp3PRO is the equivalent to 128 kBit/s in MP3.  

Multisession  
A multisession refers to completing a disc in multiple cycles. After a first session has been 

written to the disc, information can then be added in another record because the disc has not 

been finalized.  

Nero AAC  
Various MPEG-4 video and audio codecs are collated in Nero AAC and are fully compatible 

with the standard MPEG-4. Nero AG is continuing to develop these. In this way a 

substantially higher quality of the multi-media data is achieved. Further, additional features 

such as subtitles have been implemented.  

Ogg 
The container format Ogg contains digitalized or compressed multimedia files that have been 

encoded with the Vorbis method. Ogg Vorbis is an open source encoder. 

On-the-fly 
On-the-fly refers to a method for copying to a disc. The data is transferred directly from the 

original storage location to the disc to be burned. To do this, Nero uses a compilation, a 

small file that simply refers to the transferred data. 

Track-At-Once  
Track-At-Once refers to a write method in which each track is written to the disc individually. 

The writing process is interrupted briefly after each track, i.e. the laser starts again for each 

track. With this write method, it is only possible to continue writing to a DVD sometimes and 

at a later stage. There is a pause of at least 27ms between tracks, which can be disruptive 

for Audio CDs.  

WAV  
The WAV audio format, also called WAVE or Waveform audio format, is an audio format 

from Microsoft and uses no data compression. WAV is the counterpart to the AIF format from 

Apple.  
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19 Contact 
Nero Express is a Nero AG product. 
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